
第 2 章  多媒体技术与应用综合实训 

本章实训指导 

多媒体技术与应用综合实训是主要涉及多媒体素材的采集与制作的综合训练，尤其强调

对多媒体技术的基本概念以及多媒体数据格式的理解，锻炼学生掌握多媒体素材的采集与制作

的基本方法，熟练掌握应用多媒体制作工具创作多媒体的基本技能，培养学生应用多媒体工具

软件创作简单多媒体作品的能力。传统的实验项目通常较为单一，偏重一个简单的单项，本章

从应用和综合技能训练的角度出发，模拟真实社会环境，依据相关知识，根据高等职业院校学

生的实际就业岗位的特点，将重点放在理论知识的应用和综合技能的训练上。 
学习本章之前，应该学习了计算机应用基础、图形图像处理、Flash 动画设计等相关课程，

本章对以下技能进行综合实训： 
 声音信号的采集与处理 
 视频素材的获取与编辑 
 电影片尾动态字幕的制作 
 老电影效果的制作 
 虚拟演播特效的制作 
 商业广告片的制作 
 电子相册的制作 
 流媒体格式的转换与制作 

2.1  声音信号的采集与处理 

【实训目的】 

 掌握声音的基本概念。 
 掌握声音的录制。 
 掌握声音的编辑与处理。 
 掌握声音效果的添加。 
 掌握常用声音格式。 

【实训任务】 

 完成声音的录制。 
 对声音进行简单的编辑和处理：复制、剪切、粘贴、特殊粘贴、删除、调节音量和降

低噪音等。 
 对声音添加特殊效果：淡入淡出效果、混响、合唱、回音、动态等效果。 
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【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Sound Forge 
9.0、WinRAR 等软件。 

【方案设计】 

使用录音设备录制一段声音解说词，并用音频处理软件 Sound Forge 对其作相应的处理，

添加背景音乐，最后制作成一个完整的带背景音乐的 MP3 格式声音文件。 

【相关原理知识】 

1．多媒体的概念：多媒体是指把多种不同的但相互关联的媒体，如文字、声音、图形、

图像、动画、视频等综合集成在一起而产生的一种存储、传播和表现信息的全新载体。 
2．声音信号数字化过程：把时间上连续的模拟信号转变为时间上不连续的数字信号，只

要在时间间隔内取足够多的点就能逼真地模拟原来的连续信号，主要包括采样、量化和编码几

个方面。 
3．数字化声音的技术指标：采样频率，是指单位时间内的采样次数。三个标准频率分别

为 44.1kHz、22.05kHz 和 11.025kHz。量化精度，是指对模拟声音信号的振幅进行数字化表示

后的二进制位数，它决定了模拟信号数字化以后的动态范围，一般的量化精度为 8 位或 16 位。

量化精度越高，信号的动态范围越大，越可能接近原始声音信号，但文件也相对较大。声道数，

指的是一次同时产生的声波组数。有单声道和环绕立体声道两种，立体声的声音越来越好，但

对存储和传输媒体的要求也越来越高。 
4．常用声音文件格式：音频文件格式用于保存数字音频信息，其常用格式有 WAV（波形

文件）、MPEG-3（也就是 MP3 格式）、CD 音乐、MIDI（数字音频格式）等文件格式。 

【实训步骤】 

1．声音的录制 
声音信号的来源可以是接在计算机上的麦克风、线路输入、CD 播放器、MIDI 等声音，

也可以是通过音频编辑工具录制成数字的声音文件。Sound Forge 9.0 是一款音频处理软件，它

的录音功能十分强大，操作也简单。其操作步骤如下： 
（1）启动音频编辑软件 Sound Forge 9.0，单击播放条上的红色“录音”按钮，Sound Forge

会自动弹出一个新的空波形窗口和一个录音对话框，如图 2-1 所示。 
（2）在录音对话框中，单击 New 按钮，在弹出的对话框内选择合适的音频格式：采样频

率（44.1kHz）、量化精度（16 位）、声道数（2 声道），再单击 OK 按钮。 
（3）在录音对话框中，勾选两彩条（左右声道音量监视器）上的 Monitor 复选框，即可

在录音的同时监视音量的大小。若要重新显示左右声道最大音量值，则可以单击 Reset 按钮。 
（4）在录音对话框中，Method 选项值设为 Normal，录音模式 Mode 选项值设为系统默

认值，在 Start 栏里设置录音的开始时间，一般设置为 0。 
（5）双击任务栏中的声音小喇叭，打开音量控制器，选择“选项”→“属性”命令。在

弹出的“属性”对话框中选中“录音”单选按钮，并在录音控制列表中选中“麦克风”，单击

“确定”按钮。这时，音量控制器面板就变成了录音控制器面板。 
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图 2-1  波形窗口和录音对话框 

（6）单击录音对话框的 Remote 按钮，单击红色的“录音”按钮，自己对着麦克风读一

个故事或唱一首歌，需要结束录音时，单击“停止”按钮，再单击 Close 按钮，返回 Sound Forge
界面，单击“文件”→“保存”命令，保存为“解说词.wav”格式的波形文件。 

注意： 
 正式开始录音之前，一定要设置录音的通道，否则只能听到声音，而录不下来。 
 如果要减少杂音，获得好的录音效果，最好一次只激活一个放音设备。 
 如果不录制麦克风的声音，不要选中“麦克风”，否则会把外界环境的声音录到计算

机中去。 
2．声音的简单编辑和处理 
由于我们录制声音的环境和水平有限，一般要对录制好的声音进行编辑和处理。 
步骤如下： 
（1）打开录制好的声音文件，选择标准工具栏中的“编辑工具切换”工具，对声音文件

进行 Delete（清除）、Trim/Crop（修剪）等编辑动作。 
（2）选择 Process→Volume（音量）命令，打开音量调节对话框，用鼠标拖动调节音量的

滑块，或用键盘上的方向键微调，先单击 Preview 按钮，来预听效果，等声音的音量调节合适

以后，再单击 OK 按钮。 
（3）选择 Process→EQ（频率均衡）命令，选择其中最常用的 Graphic EQ（图示均衡）

来对声音进行处理，也可以单击 Preview 按钮，来预听效果，直到满意为止。 
（4）选择 Process→Fade→In 命令，即波形的前一段显示出淡入效果。同样拖动鼠标选中

波形最后一段，然后选择 Process→Fade→Out 命令，即波形的后一段显示出淡出效果。使其与

背景音乐自然融合在一起。 
（5）将编辑处理好的声音文件保存起来。 
3．声音的特殊效果的添加 
为了使声音能模拟各种空间，并增加动态效果，使我们的声音变得更丰满，需要为声音

添加各种特殊效果。 
步骤如下： 
（1）打开编辑处理好的声音文件。 
（2）为声音文件降低噪音，在菜单中选择 Effects→Noise Gate 命令，打开噪声处理对话
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框，拖动滑块调整噪音的最低限度，然后单击“确定”按钮，播放试听效果。 
（3）添加 Reverb（混响）效果，混响能模拟各种空间效果，比如教室、操场、礼堂、大

厅、山谷、体育馆、走廊、客厅、卫生间等。先选择一段波形，如果事先不选择一段波形，那

么接下来的处理就是对整条声波的。然后在菜单选择 Effects→Reverb 命令，在混响编辑窗口

中选择合适的空间效果，设置相应的参数。 
（4）若要把跑调的音调改回来或把音调升高八度，先选中要处理的一段波形，然后选择

Effects→Pitch→Shift 命令，在升降调处理窗口中，调整相应参数至满意。 
（5）再添加动态效果，使声音更加真实，先选中要处理的一段波形，然后在菜单选择Effects

→Dynamics（动态）→Graphic Dynamics/Multi-band Dynamics 命令，通过 Preset 项的下拉菜单，

选择不同的动态效果，再根据声音的具体情况灵活设置参数。 
（6）添加 Chorus（合唱）效果，它能使声音产生更丰满的变化，能极大地改变声音效果。

先选中要处理的一段波形，然后在菜单中选择 Effects→Chorus 命令，在弹出的设置界面内直

接在 Preset 项的下拉菜单中选择需要的效果。 
4．为声音添加背景音乐 
为编辑好的声音添加一些背景音乐，使它变得更加优美动听。 
步骤如下： 
（1）打开编辑好的声音文件和音乐文件。 
（2）激活音乐文件，选择一段需要的波形，单击工具条上的“复制”按钮。 
（3）激活声音文件，把鼠标放到文件开始部分，然后选择 Edit→Paste Special→Mix 命令，

弹出对话框，Peset 选项值选择 Voice over mix，并设定相关参数，单击 OK 按钮。 
（4）选择 File→Save As 命令，在弹出对话框中设定文件类型为“*.mp3”，本例命名为“解

说词.mp3”，单击“保存”按钮。 

【实训结果分析】 

本小节主要针对音频素材的基本编辑与处理进行阐述，简要介绍了 Sound Forge 音频处理

软件的常用处理方法。 

【实训报告】 

依据实训报告格式撰写实训报告。 

2.2  视频素材的编辑与处理 

【实训目的】 

 掌握视频的基本概念。 
 掌握视频素材的获取。 
 掌握视频素材的编辑与处理。 

【实训任务】 

 视频素材的获取。 
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 视频素材的剪辑。 
 给视频添加简单的特效。 

【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Adobe Premiere、
QuickTime、WinRAR 等软件。 

【方案设计】 

以“美丽的校园”为主题设计一段影片。首先通过 DV 或数码相机等摄像工具分别在宿舍、

教室、食堂和球场拍摄 4 个场景。并将录制好的视频素材导入视频编辑器，将 4 个小镜头连接

成一段短片，同时剪除多余的部分。在 4 个场景之间加上转场和字幕，添加上背景音乐，并输

出该视频。 

【相关原理知识】 

1．电视原理：电视同样也是采用动画的视觉原理构造而成的，其基本原理为顺序扫描和

传输图像信号，然后在接收端同步再现。由隔行扫描电视图像组成场，由场组成帧，一帧为一

幅图像。定义每秒钟扫描多少帧为帧频；每秒钟扫描多少场为场频；每秒钟扫描多少行为行频。 
2．场频和帧频：我国的电视画面传输率是 25 帧/秒、50 场/秒。25Hz 的帧频能以最少的

信号容量有效地满足人眼的视觉残留特性；50Hz 的场频隔行扫描，把一帧分成奇、偶两场，

奇偶的交错扫描相当于遮挡板的作用。由于我国的电网频率是 50Hz，采用 50Hz 的场刷新率

可以有效地去掉电网信号的干扰。 
3．全电视信号：电视信号中除了图像信号以外，还包括同步信号。所谓同步是指摄像端

（发送端）的行、场扫描步调要与显像端（接收端）的扫描步调完全一致，即要求同频率、同

相位才能得到一幅稳定的画面。一帧电视信号称为一个全电视信号，它又由奇数场行信号和偶

数场行信号顺序构成。 
4．分解率：电视的清晰度一般用垂直方向和水平方向的分解率来表示。垂直分解率与扫

描行数密切相关。扫描行数越多越清晰，分解率越高。我国电视图像的垂直分解率为 575 行或

称 575 线。这是一个理论值，实际分解率与扫描的有效区间有关，据统计，电视接收机实际垂

直分解率约 400 线。 
5．伴音：音频信号的频率范围一般为 20Hz～20kHz，其频带比图像信号窄得多。电视的

伴音要求与图像同步，而且不能混叠。因此一般把伴音信号放置在图像频带以外，放置的频率

点称为声音载频，我国电视信号的声音载频为 6.5MHz，伴音质量为单声道调频广播。 
6．彩色电视的制式：也就是电视信号的标准。目前各国的电视制式不尽相同，制式的区

分主要在于帧频（场频）的不同、分解率的不同、信号带宽以及载频的不同、色彩空间的转换

关系不同等。世界上现行的彩色电视制式有三种：NTSC（National Television System Committee）
制（简称 N 制）、PAL（Phase Alternation Line）制和 SECAM 制。其中 PAL 制是我国采用的

制式。 
7．数字视频的采样格式：根据电视信号的特征，亮度信号的带宽是色度信号带宽的两倍。

因此其数字化时可采用幅色采样法，即对信号的色差分量的采样率低于对亮度分量的采样率。

用 Y：U：V 来表示 YUV 三分量的采样比例，则数字视频的采样格式分别有 4:1:1、4:2:2 和
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4:4:4 三种。 
8．视频序列的 SMPTE 表示：通常用时间码来识别和记录视频数据流中的每一帧，从一

段视频的起始帧到终止帧，其间的每一帧都有一个唯一的时间码地址。根据动画和电视工程师

协会（Society of Motion Picture and Television Engineers，SMPTE）使用的时间码标准，其格式

是 00：00：00：00（小时：分钟：秒：帧）。一段长度为 00：02：31：15 的视频片段的播放

时间为 2 分钟 31 秒 15 帧，如果以每秒 30 帧的速率播放，则播放时间为 2 分钟 31.5 秒。 
9．数字视频压缩技术：视频压缩是在尽可能保证视觉效果的前提下减少视频数据率。分

为有损压缩和无损压缩、帧内压缩和帧间压缩两种类型。 
10．常用的视频格式：分为影像格式（Video Format）和流格式（Stream Video Format），

MPEG 和 AVI 是常见的影像格式，而 RM、MOV、ASF 和 WMV 是常见的流格式。 
11．存储格式/载体： 
（1）VCD 是视频压缩光盘的英文缩写，亦指一种压缩过的图像格式。 
（2）SVCD 即 MPEG-2 压缩，是我国制定的影音标准规格。 
（3）DVD 是数字视频盘片的英文缩写。DVD 利用了 MPEG-2 压缩技术，是一种大容量、

高性能的存储技术。 
（4）EVD 是增强型多媒体盘片系统的英文缩写，又称为“新一代多媒体高清晰视盘系统”，

是我国企业自行研发、拥有自主知识产权的光盘和播放机工业标准之一。 
（5）HVD 是高密度通用盘片的英文缩写，是目前高清数字视频的另一标准。HVD 的图像

清晰度达到了 720 电视线，可在 DVD-9 的光盘中存放 150 分钟的高清晰电影。HVD 播放机对

DVD 等规格完全向下兼容，在读盘能力、支持盘片类型、操作方便性等方面与 DVD 非常接近。 

【实训步骤】 

1．创建影片项目 
步骤如下： 
（1）启动 Adobe Premiere，在出现的欢迎窗口中选择“新建项目”，弹出对话框。 
（2）在对话框的“装载预置”选项卡中选择“DV-PAL”→“标准 48kHz”，也可在“自

定义设置”选项卡中根据需要设定相应的参数。设置完毕后，在名称框中输入项目的名称，本

例输入“美丽的校园”，单击“确定”按钮。 

   
图 2-2  “新建项目”对话框 
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2．导入素材 
在上面已创建好的影片项目中，导入已录制好的视频素材。导入视频素材的步骤如下： 
（1）导入 DV 机中的视频。 
1）用数据线连接好 DV 机与计算机，打开 DV 机电源并设置为 VCR 状态。 
2）选择菜单“文件”→“采集”命令，在弹出的“采集”对话框中单击“播放”按钮，

即可观看 DV 中的视频。 
3）在“采集”对话框中打开“设置”面板，在该面板中设置采集后素材文件存放的路径，

并设置倒带时间为 2 秒。 
4）在“设备控制”栏内单击“选项”按钮，在弹出的对话框内的“视频标准”栏内设置

与 DV 中的视频标准相同的制式。 
5）设置完毕后，单击“录制”按钮，即开始采集视频。 
（2）导入数码相机录制的视频。 
一般数码相机录制的视频片段的格式为 AVI 格式，它可以直接导入 Premiere，步骤如下： 
1）在菜单上选择“文件”→“导入”命令，或者在“项目”窗口的空白处双击鼠标左键，

或在“项目”窗口的空白处右击，在出现的快捷菜单中选择“输入”命令。 
2）在弹出的“输入”对话框中选择需要导入的素材，然后单击“打开”按钮。 
注意： 
 如果同时导入某个文件夹内的多个素材，可以按住 Ctrl 或 Shift 键进行多项选定。 
 如果要导入某个文件夹内的所有素材，可以直接选定该文件夹导入。 
（3）导入 DVD 或 VCD 中的视频素材。 
1）从 DVD 或 VCD 光盘中将文件复制到硬盘中，更改视频文件的扩展名为 MPG。 
2）在“项目”窗口的空白处双击鼠标左键，在弹出的“输入”对话框中选择该视频素材，

然后单击“打开”按钮。 
3．编辑视频素材 
导入的原素材中包含很多不需要的部分，因此，在合成影片之前，需要对各素材进行剪

辑修整，只保留需要的部分。一般利用素材监视器来实现。操作步骤如下： 
（1）在“项目”窗口中选中第 1 段视频素材，按住鼠标左键，将它拖动到素材监视器中，

素材即会在窗口中显示。 
（2）在“监视器”窗口中，通过拖动 （播放头），并单击窗口下方的 （单步前进）

或 （单步后退）按钮，确定一个位置后单击 （设定入点）按钮，为素材确定入点。再用

同样的方法，单击 （设定出点）按钮，为素材确定出点。 
（3）选择视频轨道 1，在“监视器”窗口左下方单击 （插入）按钮，将剪辑好的视频

插入到轨道 1 上。 
（4）直接从“项目”窗口中拖动第 2 段视频素材到时间线上第 1 段视频的后面，利用时

间线编辑该段素材。先选定该段素材，通过“剃刀”工具切割素材，删除时间线上不需要的部

分。第 3、4 段素材可以采用上述方面先后拖至时间线视频轨道 1 上。 
注意： 
 插入，用于将修剪后的素材插入到时间线中。 
 覆盖插入，以时间线中当前播放头为起点，将修剪后的素材覆盖在时间线的当前素材

之上。 
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 如果要精确定位剪辑的入点，还可以使用键盘上的左右方向键←和→，素材可以精确

向前或向后移动一帧。 
 删除时间线上的某个或某些素材，希望其后面的素材会自动填充上来，则应单击右键

选择快捷菜单中的“波纹删除”命令。 
 可以同时拖动多个素材放置到时间线上，也可以根据播放的先后顺序在“项目”窗口

中依次选择。 
（5）选择菜单“新建”→“彩色场”命令，新建一个彩色场，并将其拖至第 1 段视频开

头，以及每段视频衔接处。 
（6）选择菜单“新建”→“字幕”命令，创建四个字幕，依次拖入轨道 2 中，并放置在

彩色场正上方。 
（7）在“项目”窗口中选择“特效”选项卡，选择“视频转场”特效，拖放到彩色场与

视频衔接处。 
（8）在“项目”窗口中导入声音素材，并拖至音轨上，调整声音与视频同步，时间播放

长度相同。 
4．预览并导出影片 
（1）将播放头拖至开头，播放观看效果，并按回车键，对影片进行渲染。 
（2）选择菜单“文件”→“输出”→“影片”命令，弹出“输出影片”对话框，在名称

框中输入“美丽的校园.avi”，单击“保存”按钮。 

【实训结果分析】 

本小节主要针对视频素材的导入与素材剪辑，以及影片之间如何衔接进行了阐述，简要

介绍了 Adobe Premiere 视频处理软件的常用处理方法。 

【实训报告】 

依据实训报告格式撰写实训报告。 

2.3  动态字幕的制作 

【实训目的】 

 掌握各种字幕制作方法。 
 熟练掌握添加和设置文字字幕的方法与技巧。 
 掌握为影片添加字幕。 

【实训任务】 

 使用 Premiere 制作片尾字幕。 
 使用 Photoshop 制作标题字幕。 
 使用 Flash 制作字幕。 
 为一段完整的影片加入动态字幕。 
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【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Adobe Premiere、
Flash、QuickTime、WinRAR 等软件。 

【方案设计】 

为“美丽的校园”影片在屏幕下方加入宣传字幕和片尾加入动态字幕。 

【相关原理知识】 

参考 2.2 节的相关原理知识即可。 

【实训步骤】 

1．使用 Flash 制作文字为“故事短片”，效果为打印机的字幕动画，并保存为“字幕 1.png”。
具体步骤在此不做详细说明，读者根据已学知识自己完成。 

2．使用 Photoshop CS 制作标题字幕，具体步骤如下： 
（1）启动 Photoshop CS，选择“文件”→“新建”命令，在弹出的“新建”对话框中，

将宽度设置为 400 像素，高度设置为 300 像素，背景色为黑色。 
（2）选取“文字工具”，在文件窗口中单击鼠标左键，即在“图层”面板中形成新的图

层，在新图层上输入文字“美丽的校园”。 
（3）选中文字“美丽的校园”，打开“动作”面板，选定“默认”→“文字光晕”选项，

单击“播放”按钮，文字即出现了光晕效果。 
（4）删除背景图层，最后保存为“标题字幕.psd”。 
3．启动 Adobe Premiere，新建一个项目。在“项目”窗口空白处双击鼠标左键，打开

“输入”对话框，依次选择“美丽的校园.avi”、“字幕 1.png”、“标题字幕.psd”三个文件导

入该项目。 
4．制作片尾字幕的步骤如下： 
（1）在“项目”窗口中单击“新建”按钮，在弹出的下拉列表中选择“字幕”命令。弹

出“字幕设计”窗口，选择“文字工具”在工作区内设置文本的范围，出现光标闪动后输入以

下文件： 
 
 
 
 
 
 
 
 
 
 
在“字幕设计”窗口左上角将“字幕类型”设置为“滚动”。 
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（2）单击“字幕类型”选项右侧的 （滚动/爬行选项）按钮，在弹出的对话框中勾选

“开始屏幕”复选框，设置“缓慢入”和“缓慢出”均为 0 帧，设置“向后滚”为 100 帧。单

击“文件”→“保存”命令，保存为“片尾字幕.prtl”，并出现在“项目”窗口中。 
5．为影片添加字幕。 
（1）从“项目”窗口中选中“美丽的校园.avi”拖至视频轨道 1。 
（2）选定视频轨道 2，从“项目”窗口中选中“字幕 1.png”动画，拖至轨道 2 起始时间

帧。在“监视器”窗口中，选中“特效控制”面板，将文字调整至合适的位置。 
（3）选定视频轨道 3，从“项目”窗口中选中“标题字幕.psd”拖至轨道 3。在弹出的对

话框中选中“合并图层”选项，单击“确定”按钮。在“监视器”窗口中，选中“特效控制”

面板，将文字调整至合适的位置。 
（4）添加并选中视频轨道 4，从“项目”窗口中选中“片尾字幕.prtl”拖至轨道 4。在“监

视器”窗口中，选中“特效控制”面板，将文字调整至合适的位置。 
（5）在 4 个视频轨道上，使用移动工具，以“字幕 1”、“标题字幕”、“美丽的校园”、“片

尾字幕”为顺序，使 4 段素材很好地衔接成一段影片。 
6．预览并导出影片。 
（1）将播放头拖至开头，播放观看效果，并按回车键，对影片进行渲染。 
（2）选择菜单“文件”→“输出”→“影片”命令，弹出“输出影片”对话框，在名称

框中输入“带字幕的美丽的校园.avi”，单击“保存”按钮。 
注意： 
 插入，用于将修剪后的素材插入到时间线中。 
 覆盖插入，以时间线中当前播放头为起点，将修剪后的素材覆盖在时间线的当前素材

之上。 
 如果要精确定位剪辑的入点，还可以使用键盘上的左右方向键←和→，素材可以精确

向前或向后移动一帧。 
 删除时间线上的某个或某些素材，希望其后面的素材会自动填充上来，则应单击右键

选择快捷菜单中的“波纹删除”命令。 
 可以同时拖动多个素材放置到时间线上，也可以根据播放的先后顺序在“项目”窗口

中依次选择。 
 输入中文时，应注意在“属性”选项栏的下拉列表中，单击“字体”选项右边的

长方条，即可设置所输入文字的中文字体。同时可以在属性栏中设置文字的相关

属性。 

【实训结果分析】 

本小节主要通过为影片制作各种动态效果的字幕，介绍了 Premiere 字幕设计窗口的使用，

以及与其他软件如 Photoshop、Flash 的相互配合。 

【实训报告】 

依据实训报告格式撰写实训报告。 
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2.4  老电影效果的制作 

【实训目的】 

 掌握 Premiere 软件中视频 AE 插件中 AgedFilm（老电影效果）插件的使用。 
 掌握用 AgedFilm 插件模仿老电影的原理。 

【实训任务】 

 利用 AgedFilm（老电影效果）插件制作老电影效果影片。 
 为视频素材加上噪点、线条、频闪、抖动等效果。 

【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Adobe Premiere、
Flash、QuickTime、WinRAR 等软件。 

【方案设计】 

为一段影片添加老电影效果。 

【相关原理知识】 

老电影的制作原理是为电影加上噪点、线条、频闪、抖动等效果。 

【实训步骤】 

1．安装 AE 插件。AE 插件的安装方法是，复制“AgedFilm.AEX”插件到 Premiere 安装

目录的 Plug-ins 目录下，如图 2-3 所示。 

 
图 2-3  AE 插件的安装 
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2．安装好 AE 插件，导入想要做特效的视频影像，并添加到时间视频轨道上。再给该视

频作一个色调特效，把明亮的色彩调淡，并调至浅黄色。 
3．然后就可以添加“老电影”特效了。在“特效”面板中找到“AgedFilm”插件，拖至

该影像上，如图 2-4 所示。并在“特效控制”面板设置其相应参数，得到如图 2-4 所示“老电

影”效果。 

   
图 2-4  老电影效果图 

4．预览并导出影片。 
（1）将播放头拖至开头，播放观看效果，并按回车键，对影片进行渲染。 
（2）选择菜单“文件”→“输出”→“影片”命令，弹出“输出影片”对话框，在名称

框输入“老电影效果.avi”，单击“保存”按钮。 

【实训结果分析】 

本小节主要通过“老电影”效果插件为影片制作老电影效果，从而熟练掌握 AE 插件效果

的使用。 

【实训报告】 

依据实训报告格式撰写实训报告。 

2.5  虚拟演播室效果的制作 

【实训目的】 

 掌握抠像技术的原理及应用。 
 熟练掌握“键控”滤镜组命令的应用。 

【实训任务】 

 利用“键控”滤镜完成电影“抠像”特技效果。 
 利用“蓝色或绿色抠像”技术完成虚拟演播室效果的制作。 
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【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Adobe Premiere、
Flash、QuickTime、WinRAR 等软件。 

【方案设计】 

制作虚拟演播室的效果，在演播室内合成影片中难以完成的高难度动作，使节目变得更

加精彩有趣。 

【相关原理知识】 

抠像技术是指把单一颜色的背景抠除（大多是蓝色，绿色）换为事先拍好的背景，比如

《西游记》中孙悟空砍头的场景，就是在砍头的时候，把同原来背景一样的颜色的布蒙在头上，

这样就拍成了“无头”的样子。 
抠像技术也是后期软件中的一个名词，现在用于大量的电影、电视、游戏制作当中。抠

像的原理就是把图像中特有的颜色抠除，从而加上想要的效果。目前主要的抠像有两种：蓝屏

抠像和绿屏抠像。 
其实两者的区别不是很大，操作起来的步骤也是一样的，唯一不同的地方就是在拍摄过

程中，后面背景的颜色不一样。目前在国内大部分是用蓝屏，而在美国大部分是用绿屏抠像。

其实之所以用这两种颜色，是因为人体内不含这两种颜色。这样在后期的抠像过程中，不会把

人体的皮肤一起抠除掉。 

【实训步骤】 

1．启动 Premiere 视频编辑软件，创建一个名为“虚拟演播室”的工程文件。 
2．导入两个视频素材（包括蓝色背景视频或图片）。 
3．在“视频 2”轨道中添加蓝色背景视频素材，在“视频 1”轨道中添加另一个视频素

材。使“视频 2”轨道中的素材将“视频 1”轨道中的素材遮盖住，如图 2-5 所示。 

 
图 2-5  添加素材 

4．选中“视频 2”轨道中的素材，选择“特效控制”面板，添加位置、缩放和旋转等处

的关键帧，制作关键帧动画，如图 2-6 所示。 
5．选择“特效”面板，选中“键控”文件夹，将其中“蓝色抠像”键控特效拖入“时间

线”面板的“视频”轨道中，为其中的素材应用键控特效。 
6．选中“视频 2”轨道中的素材，在“特效控制”面板中调整相应的参数，使其素材中

蓝色背景完全消失。 
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 图 2-6  特效控制 图 2-7  应用“蓝屏抠像”效果图 

7．预览并导出影片。 
（1）将播放头拖至开头，播放观看效果，并按回车键，对影片进行渲染。 
（2）选择菜单“文件”→“输出”→“影片”命令，弹出“输出影片”对话框，在名称

框中输入“虚拟演播室.avi”，单击“保存”按钮。 
注意：在制作虚拟演播室效果时，可以采用键控效果中的绿屏抠像、亮度键、屏幕键和

图像遮罩等特效。 

【实训结果分析】 

本小节主要以键控特效中的“蓝色抠像”特效为例，为影片制作虚拟演播室的效果。 

【实训报告】 

依据实训报告格式撰写实训报告。 

2.6  商业广告片的制作 

【实训目的】 

 掌握广告片的基本类型及制作流程。 
 掌握制作广告片。 

【实训任务】 

 确定广告主题、画面及音乐。 
 制作广告字幕。 
 制作广告特效。 

【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Adobe Premiere、
Flash、QuickTime、WinRAR 等软件。 
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【方案设计】 

试为一家“化妆品”公司设计制作一个宣传片。 
1．根据策划方案写出基本设计制作要求，主要包括：公司介绍、项目或产品描述、风格

内容等方面。 
2．根据需要的画面策划拍摄，首先定下需要拍摄的内容。哪些是可以用素材的，哪些是

务必要拍到的，确定一下拍摄时间和周期。 
3．拍摄，上面的准备工作都安排好后，开始准备拍摄。 
4．选择背景音乐。 
5．音乐剪辑，根据自己确定的方案按每个章节排一时间线。先要把自己所需要的镜头和

必要镜头确定下来。 
6．视频剪辑。 
7．配合音乐调整镜头，这一步就是要根据音乐部分来调整镜头，让镜头和音乐协调起来。 
8．调色，剪辑完之后接下来就需要调整一下颜色。主要是补充拍摄的不足，尽量还原真

实色彩。 
9．特效和合成，颜色调完了，对影片制作一些特效。再把片头和片尾放到影片中合成。 

【相关原理知识】 

1．广告片三要素。广告片借以表现广告信息的基本要素，包括图像、声音和时间。图像

是具体、动态的景物形状与颜色的影像。图像是广告片的主要构成要素，具有生动、直观、具

体等特点，一个镜头就可以提供综合多样的视觉信息。声音是广告片表现的另一个重要因素，

声音与图像配合，可以向观众提供丰富的信息，具有很强的表现力和真实感。广告片的主要特

征是将所有传达的信息存放在时间的流程中，离开了时间因素，信息就无法传达。广告中的时

间是指广告的实际长度、广告片的表现时间和观众的心理感受时间。视觉和听觉都要通过时间

来构成变化和节奏。 
2．广告片片型。是广告片结构的形式，它体现了广告的整体创意，在选择广告片片型时，

要注意结构形式是否符合广告创意的要求，是否符合广告产品的诉求点和广告的主题思想，是

否对产品的宣传有利，是否能被观众接受。主要包括以下几种类型： 
（1）新闻报道型。这类型的广告片是运用新闻报道的形式，以记实的手法把有新闻价值

的商品信息记录下来，通过电视进行广告宣传的一种方式。 
（2）示范证明型。主要通过名人、专家和产品使用者去说明和验证广告产品的功能和优

点，介绍产品能给消费者带来什么好处。分为引证式和名人推荐式。 
（3）悬念问答型。是由一个疑问者提出问题，再由一个相信者回答问题的广告。 
（4）生活片段情感型。把人们在日常生活中对某种商品的谈论和评价的事实，通过电视

技术把其中的一部分加以艺术加工再现于电视屏幕的一种广告制作手法。 
（5）气氛型。是通过一个特定的场所、特定的事物来营造生活和人的情感氛围。 
3．广告片制作方式。目前广告片制作较为普遍选用的方式有现场拍摄、演播室拍摄和电

脑绘画等三种。 
（1）现场拍摄制作方式。是由广告制作人员携带摄像设备到现场直接把广告内容拍摄下

来，经稍加剪接即可播出的一种广告制作方式。 
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（2）演播室拍摄制作方式。是广告制作人员根据创意要求，需要进行置景和造型设计的

一种广告拍摄方式。 
（3）电脑绘画制作方式。是由广告创作设计人员向电脑编程人员提供广告创意和广告效

果图，电脑编程人员通过计算机编制程序，绘制广告画面的一种广告制作方式。 
4．广告片发布形式。 
（1）特约播映广告。是指电视台为广告客户提供的特定广告播出时间，客户通过订购这

类广告时间，把自己的产品广告在指定的电视节目的前、后或中间播出的一种广告宣传方式。 
（2）普通广告。指电视台在每天的播出时间里划定的几个时间段，供客户播放广告的一

种广告宣传方式。 
（3）经济信息。是广告片的一种宣传方式，是电视台专门为工商企业设置的广告时间段，

是专门为客户产品的推广、产品鉴定、产品质量咨询、产品联展联销活动，以及企业和其他单

位的开业等方面的宣传服务的。 
（4）直销广告。指电视台为客户专门设置的广告时间段。利用这个时间段专门为某一个

厂家或企业，向广大观众介绍自己生产或销售的产品和商品。 
（5）文字广告。只是在电视屏幕上打出文字并配上声音的一种最简单的广告播放方式。 
（6）公益广告。是一种免费的广告，主要是由电视台根据各个时期的中心任务，制作播

出一些具有宣扬社会公德、树立良好社会风尚的广告片。 

【实训步骤】 

1．启动 Adobe Premiere Pro，新建一个项目文件，将所需要素材导入到“项目”窗口中。 
2．添加一个彩色转场，并将其拖入时间线“视频 1”轨道中。 
3．根据出场顺序，依次选择广告画面，然后将它们拖到时间线“视频 2”轨道中。 
4．在“视频 2”轨道中，选择第一个画面，在“特效控制”面板中单击“位置”左侧的

“关键帧”按钮，系统自动添加一个关键帧，设置“位置”参数。 
5．移动播放头到下一个位置，添加一个关键帧，设置其“位置”和“比例”参数。使其

产生由远到近的效果。 
6．移动播放头到下一个位置，添加一个关键帧，在“特效”面板中，为该画面添加相应

的视频特效。 
7．用同样方法，调整其他画面的视频特效。 
8．制作“字幕”文件，编辑并保存。 
9．在时间线“视频 3”轨道中，导入“字幕”，在“特效”面板中调整其大小和位置，应

用“4 点-可调控遮罩”视频特效，并添加关键帧。 
10．将视频素材拖入“监视器”窗口中，对其进行剪辑，并插入到“视频 4”轨道中。 
11．在“特效控制”面板中为该素材添加“溶解”视频效果。 
12．导入声音素材到“音频 1”轨道中，显示“音频 1”轨道关键帧，在影片的开头和结

尾处分别添加两个关键帧，添加声音的“淡入淡出”效果。 
13．预览并导出影片。 
（1）将播放头拖至开头，播放观看效果，并按回车键，对影片进行渲染。 
（2）选择菜单“文件”→“输出”→“影片”命令，弹出“输出影片”对话框，在名称

框中输入“广告片.avi”，单击“保存”按钮。 



电子商务应用综合实训指导 38 

【实训结果分析】 

本小节主要通过视频编辑软件制作一个广告片，掌握广告片制作流程。 

【实训报告】 

依据实训报告格式撰写实训报告。 

2.7  电子相册的制作 

【实训目的】 

 掌握利用 Photoshop 处理图片的技巧与方法。 
 掌握利用 Photoshop 制作相册模板。 
 熟练掌握 Premiere 转场特效。 

【实训任务】 

 数字相片的采集与整理。 
 利用 Photoshop 制作电子相册模板以及模板的应用。 
 使用 Premiere 将相片、文字、声音等组成一个视频文件。 

【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Adobe Premiere、
Flash、QuickTime、WinRAR 等软件。 

【方案设计】 

给自己制作一套数码艺术照相册，首先收集生活照和一些优美的背景画面，通过 Photoshop
软件制作一套相册模板，并保存为模板文件。 

【相关原理知识】 

参考 2.2 节的相关原理知识即可。 

【实训步骤】 

1．素材的收集与整理 
定制相片的大小。可以把相片分成两类：横幅图像和竖幅图像，定制裁剪工具长和宽，

利用 Photoshop 快速地将相片裁切成统一的大小。 
（1）启动 Photoshop，打开需要编辑竖幅的相片文件。在“动作”面板的“默认动作组”

中单击“新建动作”按钮，在弹出的“新动作”对话框中设置相关属性，并命名为“竖幅裁剪”。

单击“记录”按钮，开始记录动作。 
（2）在工具栏选择“裁切”工具，在该工具的选项栏中设置：宽度为 576 像素，高度为

768 像素。在图像中拖动鼠标即可拖出裁切框，在裁切框内双击鼠标左键，图像会自动被裁切

为 576 像素×768 像素。在“动作”面板上单击“停止记录”按钮。 
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（3）在菜单中选择“文件”→“自动”→“批处理”命令，在弹出的“批处理”对话框

中，修改“动作”栏下拉列表选项为“竖幅裁剪”，单击“好”按钮。 
（4）采用同样的方法，定制所有横幅的图像。 
2．制作相片的字幕 
启动 Photoshop 图像处理软件，新建一个文字文件，在工具栏选择“文字”工具，在图像

中输入文字，并添加效果。删除背景图层，并保存为 PSD 格式的文件。 
3．导入素材 
（1）启动 Premiere 视频编辑器，选择“编辑”→“参数设定”→“常规”命令，在弹出

的“参数”对话框中，在列表框中选择“常规”选项，设定默认视频切换持续时间为 30 帧，

选择“静态图像”，设定默认的持续时间为 125 帧。单击“确定”按钮。 
（2）导入照片素材，并添加到时间线的“视频 1”轨道中。 
（3）为照片制作淡入淡出效果。在时间线“视频 1”轨道名称栏上单击“显示关键帧”

图标，在弹出的显示列表中选择“显示透明控制”。将时间指针拖动到第 2 秒处，单击“添加/
删除关键帧”按钮插入关键帧，再将时间针拖动到第 0 秒处，单击“添加/删除关键帧”按钮

插入关键帧，并将新加入的关键帧向下拖动；将时间指针拖动到第 4 秒处，单击“添加/删除

关键帧”按钮插入关键帧，再将时间指针拖动到该照片结束处，单击“添加/删除关键帧”按

钮插入关键帧，并将新加入的关键帧向下拖动。 
（4）选中“视频 1”轨道中的第 1 张照片，单击右键，在弹出的快捷菜单中选择“复制”

命令，然后拖动一个矩形框，选中其他照片素材，并在照片上单击右键，在弹出的快捷菜单中

选择“粘贴属性”命令。这样，其他照片素材就有了第 1 张照片的淡入淡出效果。 
（5）选中第 1 张照片，在“特效控制”面板中选择“运动”选项，在时间线窗口中将其

调整到适当的大小。在“特效控制”面板中选择“运动”选项，单击菜单“编辑”→“复制”

命令，然后选中其他照片素材，单击菜单“编辑”→“粘贴”命令。这样，其他照片素材就有

了第 1 张照片的大小。 
（6）在“视频 2”轨道中添加第 1 张照片的字幕文件，并与第 1 张照片时间相同。为字

幕文件制作淡入淡出效果。 
（7）为其余照片添加字幕文件，采用方法与制作照片淡入淡出相同。 
（8）在第 1 张和第 2 张照片之间插入“翻筋斗”转场特效，在“特效控制”面板中设置

具体参数。 
（9）用同样的方法，在每两张照片之间插入一种转场特效。 
（10）导入音乐素材到时间线“音频 1”轨道中，并设其时间与视频一样长。 
4．预览并导出影片 
（1）将播放头拖至开头，播放观看效果，并按回车键，对影片进行渲染。 
（2）选择菜单“文件”→“输出”→“影片”命令，弹出“输出影片”对话框，在名称

框中输入“电子相册.avi”，单击“保存”按钮。 
注意： 
 生成用于刻录 VCD 或 DVD 光盘的视频时，视频的文件名要用英文或数字，因为有

些 VCD 或 DVD 播放机不支持中文名称。 
 直接生成 MPG 格式的视频时，影片中设置的某些轨道层之间的混合模式可能失效，

如屏幕键抠像模式。 
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【实训结果分析】 

本小节主要通过制作电子相册实例，综合运用 Premiere 的多种特效及 Photoshop 相互配合

的技巧。 
【实训报告】 

依据实训报告格式撰写实训报告。 

2.8  流媒体视频格式的制作 

【实训目的】 

 掌握流媒体技术的概念及其文件格式。 
 掌握流媒体技术的原理。 
 掌握常用流媒体格式的制作。 

【实训任务】 

 其他视频格式转换成 FLV 流媒体格式。 
 在网页中插入 FLV 流媒体。 

【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Adobe Premiere、
Flash、WinRAR 等软件。 

【方案设计】 

将自己制作的电子相册视频文件转换成 FLV 流媒体格式，并添加在自己的主页中。 

【相关原理知识】 

1．流媒体是指在数据网络上按时间先后次序传输和播放的连续音频、视频数据流。流媒

体数据流具有 3 个特点：连续性、实时性、时序性，即其数据流具有严格的前后时序关系。 
2．流媒体技术就是将声音、影像或动画由服务器向用户计算机进行连续、不间断传送，

用户不必等到整个文件全部下载完毕，而只需经过几秒或十几秒的启动延时即可进行观看。当

声音、视频等在用户的机器上播放时，文件的剩余部分还会从服务器上继续下载。流式传输技

术又分两种，一种是顺序流式传输，另一种是实时流式传输。 
3．常用流媒体的文件格式。 
（1）微软的 ASF（Advanced Stream Format）。这类文件的后缀是.asf 和.wmv，与之对应

的播放器是微软公司的 Windows Media Player。用户可以将图形、声音和动画数据组合成一个

ASF 格式的文件，也可以将其他格式的视频和音频转换为 ASF 格式，还可以通过声卡和视频

捕获卡将诸如麦克风、录像机等外设的数据保存为 ASF 格式。 
（2）RealNetworks 公司的 RealMedia，它包括 RealAudio、RealVideo 和 RealFlash 三类文

件。其中 RealAudio 用来传输接近 CD 音质的音频数据，RealVideo 用来传输不间断的视频数



第 2 章  多媒体技术与应用综合实训 41

据，RealFlash 则是 RealNetworks 公司与 Macromedia 公司联合推出的一种高压缩比的动画格

式，这类文件的后缀是.rm，对应的播放器是 RealPlayer。 
（3）苹果公司的 QuickTime。这类文件的扩展名通常是.mov，对应的播放器是 QuickTime。 
（4）FLV 流媒体格式是一种新的视频格式，全称为 Flash Video。它是在 Sorenson 公司的

压缩算法的基础上开发出来的，文件扩展名是.flv。它的播放器是嵌入在浏览器中的 Flash 播

放器，播放速度极快，可以不通过本地的 Windows Media Player 或者 Real Player 播放器播放

视频。FLV 压缩与转换非常方便，适合做短片。 
此外，MPEG、AVI、DVI、SWF 等都是适用于流媒体技术的文件格式。 

【实训步骤】 

1．打开 Flash MX 2004，新建一个 Flash 文档。单击菜单“文件”→“导入”→“导入到

库”命令，在弹出的“导入”对话框中选择“电子相册.avi”视频文件，单击“导入”按钮。 
2．启动“向导”对话框，选择“导入整个视频”单选按钮，单击“下一步”按钮，再设

置“压缩配置文件”为“DSL/Cache 256 kb/s”选项，单击“完成”按钮。如图 2-8 所示。 

   
图 2-8  “向导”对话框 

3．选择菜单“窗口”→“库”命令，打开媒体库，如图 2-9 所示。 

 
图 2-9  “库”面板 

4．在“库”面板中，右击“电子相册.avi”，在弹出的快捷菜单中选择“属性”命令，弹
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出如图 2-10 所示的对话框。 

 
图 2-10  “嵌入视频属性”对话框 

5．单击“导出”按钮，在弹出的“导出 FLV”对话框中，输入文件名，单击“保存”按

钮。然后，退出 Flash 编辑状态，即“电子相册.flv”制作成功。 
6．在网页中添加 FLV 视频 
打开 Dreamwaver 8，打开插入面板，选择常用类别，单击媒体按钮后的向下箭头，从下

拉列表中选择“Flash 视频”。在弹出的对话框中，URL 选项选择“电子相册.flv”视频文件，

宽度设为 352，高度设为 200，勾选“自动播放”选项，单击“确定”按钮。 
7．设置完毕后，自动生成了 FLVPlayer_Progressive.swf 播放器文件和 Halo_Skin_3.swf 控

制器皮肤文件。保存该网页。 
注意： 
 flv 文件必须定义在 Dreamweaver 当前站点中，以获得相对路径，便于所有文件一起

上传。 
 上传网页时需要上传 4 个文件： FLV 视频所在页面、 FLV 视频文件、 

FLVPlayer_Progressive.swf 播放器文件和 Halo_Skin_3.swf 控制器皮肤文件。 

【实训结果分析】 

本小节主要介绍将常用视频格式转换为 FLV 流媒体，并在网页中添加 FLV 流媒体的方法。 

【实训报告】 

依据实训报告格式撰写实训报告。 

2.9  仿真模拟案例 

【实训目的】 

为某企业制作一个专题宣传片，掌握从前期策划、脚本创作、拍摄、剪辑、配音配乐，

到后期光盘压制等全方位的影片制作过程。 

【实训任务】 

利用视频处理软件处理视频素材、解说、字幕、动画等多媒体。 
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【实训环境】 

能够访问 Internet 的多媒体计算机（包括声卡、耳机），并安装有 Photoshop、Adobe Premiere、
Flash、QuickTime、WinRAR 等软件。 

【方案设计】 

立足历史，放眼未来，回顾新志诚地产公司十年风雨历程，展望企业在全球化和市场经

济时代大潮中搏击的宏伟抱负。重点是新志诚地产产品品牌以及企业品牌，借此阐述本建筑公

司开发地产的理念以及企业经营理念。 
1．基本理念 
宣传片的主题，是向北京市民宣传新志诚地产，展示新志诚的历史、企业文化、楼盘建

筑、企业理念、辉煌成绩以及新志诚人的精神风貌。宣传片主要遵循新闻和传播规律，增强宣

传片的亲和力和传播效果。通过此宣传片，使广大市民，特别是新志诚的潜在消费群体，了解

新志诚的历史与现状和新志诚的开发建设理念，从而达到引导消费和塑造企业品牌的目的。 
2．宣传片定位 
以企业发展的历史作为节目的主线，从效果上讲是最佳的、最容易引起共鸣。以一个时

期或与这个时期有关联的事件为主要对象，作为描述的主体内容。 
3．宣传重点 
重点是宣传新志诚地产产品品牌以及企业品牌，借此阐述本建筑公司开发房地产的理念

以及企业经营理念。从而达到提升企业品牌、产品品牌的目的，起到引导潜在消费者的效果。 
（1）温馨花园产品品牌。 
（2）新志诚房地产企业品牌。 
（3）十年历史回顾。 
4．宣传片篇章设计 
（1）历史篇章：从新志诚的过去到现在十年发展历程。 
（2）成就篇章。 
1）温馨花园产品品牌。 
从楼盘的开发建设、园林装饰、楼盘营销、业主入住、物业管理等整个产业流程角度着

眼，贯穿新志诚地产开发的一系列楼盘，诸如梨花苑、玫瑰苑、新上城等楼盘，阐释新志诚地

产开发房地产的理念，突出新志诚在地产界的重要地位。 
2）新志诚地产企业品牌。 
突出新志诚在地产界的重要地位。 
（3）战略篇章。 
今后的发展规划以及发展战略，公司管理革新的历程，以及先进的管理理念。如质量管

理体系和企业主题年的推广等。 
（4）人才篇章。 
书写新志诚地产的员工，展现公司良好的精神风貌以及对企业的认同度；并展现公司员

工文化素质、业务素质等各个方面。突出公司的人力资源优势。 
（5）文化篇章。 
公司管理革新历程，以及先进的管理理念。新志诚地产对社会的贡献以及社会对企业的
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认同感。开展的一系列的社区活动。 
5．节目时长 
专题片的时间长度为 15 分钟左右。这是一个能基本完整、全面地叙述企业历史与有关背

景、刻画细节，充分表现新志诚地产整体形象的时间。 
6．表现手法 
本系列专题片的表现手法以实景纪实拍摄为主，辅之以适量的采访。 
7．总体要求 
直白、平实、不矫饰；同时，尽量展现企业主流文化、要生动、有一定深度。 

【相关原理知识】 

1．企业宣传片（TV-Show）：是以电视摄制设备为制成手段，通过专业和整体的电视导演

系统生成，以电视机或网络电视为播放载体，以企业形象或企业产品宣传为初始目的，对企业

营销、形象展示、长期品牌战略产生影响并共同服务。 
2．企业宣传片适用范围：一般适用于政府、经济技术开发区招商宣传，旅游景点、宾馆、

酒店、房地产的宣传推广、企业形象和自我形象的宣传、产品业务推广。传播的信息量大，方

式多样，具有实用及观赏价值，广告成本低、易携带、邮寄，使用方便。 
3．企业宣传片时长问题：宣传片的长度没有绝对的最好的长度，要根据具体需要。通常

情况，宣传片的长度在 10 分钟左右，因为根据科学家的研究发现，成年人的注意力关注度最

长为 10 分钟。所以我们建议宣传片的长度一般要在 8～12 分钟之间，这样既有充足的时间传

达产品和服务的信息，也不会使宣传片过于冗长。 

【实训步骤】 

1．制作组与客户初次沟通，了解客户需求。 
2．与客户亲密接触，详尽了解企业和产品（或城市特点）。 
3．制片组和创意人员做出初期创意脚本方案。 
4．向客户提供详细报价并与之积极沟通，签订制作协议书或合同书。 
5．整理现有相关资料素材，撰写文案，制作分镜头本。 
6．客户确认文案，进入实拍。 
7．对全部影音资料进行后期编辑，包括剪辑、特效、配音，并输出样片。 
8．请客户观看样片，并提出小面积的修改意见。 
9．按照客户意见进行深入修改，录音合成。 
10．请客户最后看片，并提供协议商定的播出带或 DVD 和 VCD。 
11．建立客户资料档案，以及其他完整的后续服务。 

【实训结果分析】 

本小节主要通过仿真模拟练习，充分掌握多媒体影片的制作流程。 

【实训报告】 

依据实训报告格式撰写实训报告。 
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思考与练习 

1．获取两段音频素材，并对这两段素材编辑实现山谷回音效果。 
2．试为一个少儿节目制作以“迎奥运”为主题的宣传片。 
3．剪辑一段电影并处理成单色效果。 
4．采用“绿屏抠像”技术，为一段影片添加特技效果。 
5．制作一份电子贺卡。 
6．拍摄一些生活趣事，然后编辑制作成一部生活趣事片，并以 FLV 流媒体格式保存，并

发布在自己的个人主页中。 
 
 


